
NEW FEATURES README FILE FOR DESIGNCAD 2D FOR WINDOWS

Table of Contents 

--- Section 1 ---    What's New
--- Section 2 ---    BasicCAD Notes
--- Section 3 ---    Menu Customization
--- Section 4 ---    ToolBox Customization
--- Section 5 ---    Symbol ToolBox Customization
--- Section 6 ---    Command Prompt Customization

--------------------------------------------------------------------------------------------------------------------
--- Section 1 ---    What's New
--------------------------------------------------------------------------------------------------------------------

First and most obvious, if you are re-installing DesignCAD for Windows, there is now only this 
one Readme file. Check the Table of Contents above, and go to the heading that interests you 
most. Also note the changed icon for the readme file and the addition of a help icon for 
DesignCAD and the Symbols.

There are numerous changes to BasicCAD. Be sure and check out the BasicCAD section for 
further details. Also be sure to check out the sample BasicCAD programs. A new one, 
DEMO.BSC, illustrates many of the new capabilities.

DesignCAD is now even MORE customizable than before. We had already added in the ability to 
modify the main toolbox and the pulldown menus. Now you can also create customized groups of
symbols, up to 40 groups of 40 symbols each, and access them in the symbol toolbox. You can 
select symbol groups from the hot toolbox, the main toolbox, or the pulldown menu. In addition, 
you can even modify the prompts that the individual commands display to help you set points. For
example, you could modify CIRCLE-1's prompt from "set these points: 1 center, 2 radius"  to "Set 
a point for the center, then a point which the circle crosses."

--------------------------------------------------------------------------------------------------------------------
--- Section 2 ---    BasicCAD Notes
--------------------------------------------------------------------------------------------------------------------

_____Newest Features_____ (08-03-94)

New Sys() functions:
Sys(42) sets the distance that Parallel-2 works with.
Sys(80) returns the number of selected entities
Sys(600) Minimum X-value of the current display area
Sys(601) Maximum X-value of the current display area
Sys(602) Minimum Y-value of the current display area
Sys(603) Maximum  Y-value of the current display area

Obsolete Sys() function: 
Sys(92) is no longer supported. See Sys$(92) below.

New Sys$() function: 
Sys$(92) is a replacement for the old sys(92), which returned the color of an entity 

picked with the entity command. Sys$(92) returns a 9-character string giving the 
RGB values of the entity's color. The first three characters represent the R value, the 
second three the G value, and the last three the B value.



***DON'T RELY ON THE OLD SYS(92)!  USE SYS$(92) INSTEAD.***

New BasicCAD statement: 

GETSELECT index, entitynumber
This statement allows you to retrieve the entity number(s) of a selected entity(s). index 

represents the order in which the items were selected. entitynumber represents 
the entity number of the indexed entity. Like SYS(80), GETSELECT will ignore any 
selection changes made by PUTATTR or GETATTR.

precision 0
for i = 1 to sys(80)
getselect i, j
print "Selection index ", i, " is entity number ", j
anykey
next i

Changes to ENTITY statement:
* ENTITY statement now sets the points of the referenced entity IF you are in 

   >PRESETPOINTMODE before you issue the statement. 

* Sys(92) is no longer supported. See discussion of SYS$(92) above.

'This code fragment prints the RGB values of each entity in the drawing and sets the points in 
' each entity

dim x (50)
dim y (50)
>presetpointmode
for i = 1 to sys(9)
  entity i
  npts = sys(1)
     for j = 1 to sys(1)
        pointval x(j) y(j) j
     next j
     sys(1)=0
  a$=sys$(92)
  r$=left$(a$,3)
  r = val(r$)
  g$=mid$(a$,4,3)
  g = val(g$)
  b$ = right$(a$,3)
  b = val(b$)
  print "r =", r,"   g = ",g,"   b = ", b
  anykey
next i      

>UNDO  Usage note:
Do not use >UNDO in DesignCAD for Windows to remove points that have been set by 

SETPOINT or by DesignCAD commands. Use either >DELETELAST to remove 
the most recent point, or to remove all points set SYS(1)=0.

Changes to GETATTR and PUTATTR:



Change the reference manual to say
GETATTR entity, type {,select, layer, group, rvalue, gvalue, bvalue}

and
PUTATTR entity, type {, select, layer, group, rvalue, gvalue, bvalue}

where rvalue, gvalue, bvalue are the RGB values of the entity's color. DesignCAD for Windows 
has no means of dealing with single-number color values. All it is aware of are RGB values.

When you alter the layer of an item with PUTATTR, the layer dialog box in the coordinate bar is 
NOT automatically updated to reflect the change, although ID'ing the object in question will show 
the correct layer. If you set the current layer with the LAYER statement, all such changes WILL be
updated and shown on the coordinate bar.

REGEN statement now works just like >regenerate command.

ZOOM command now takes 2 parameters
>zoom parm1, parm2

parm1 =0 for normal zoom or 1 for static zoom
parm2 = zoom factor

INTERSECT-2 command now takes four parameters
>intersect-2 X1,Y1,X2,Y2

where X1 and Y1 are a point on the first line and X2 and Y2 are a point on the second line.

--------------------New Features------------------------  (04-01-94)

New Sys() function: 
Sys(999) -- indicates whether the ESCAPE key was pressed in a dialog box -- 1=yes,    

           0=no

New SYS$() function: 
Sys$(40)  -- allows user to copy a text string to/from the clipboard 

-------------------------------------------------------------
The SYS Functions -- DesignCAD 2D Version 7.0

The valid ranges for the sys() functions are as follows:

1 - Number of points set  [0-200]

3 - Current layer   [0-255]
4 - Current line type  [0-12]
5 - Line type scale  [0<=x<=10e6]
6 - Current line width  [0<=x<=10e6]
7 - Current precision  [-7<=x<=7]

9 - Number of entities in the drawing  [read_only]
10 - Units of measurement for display - 1=inches, 2.54=cm.
11 - Units per inch on output. [0<=x<=10e6]
12 - Default text size  [0<=x<=10e6]
13 - Default text angle  [-360<=x<=360]



14 - Display grid type  [1, 2, 3]
15 - Display grid enable/disable  [0, 1]

17 - Snap grid on or off  [0, 1]

19 - Display grid size  [0<=x<=10e6]
20 - Snap grid size  [0<=x<=10e6]
21 - Attribute display enable/disable  [0, 1]
22 - Save parameters with drawing, enable/disable  [0, 1]
23 - Mathematical or geographical angles  [0, 1]
24 - Fill wide lines enable/disable  [0, 1]
25 - Sound on/error only/off  [0, 1, 2]
26 - Manipulate current layer only  [0, 1]
27 - Status line format  [0, 1]

29 - Point type  [1,2]
30 - Large cursor step size  [0<=x<=10e6]
31 - Small cursor step size  [0<=x<=10e6]
32 - Drawing unit size   [0<=x<=10e6]

34 - Returns 1 if entities are selected, 0 otherwise. [read_only]
35 - Number of sides in the rubber band polygon  [3-254]
36 - Silent mode (1 for silent, 0 for normal)
37 - Cursor step consistent with Screen or Drawing  [1,2]
38 - Text mirror disable  [0,1]
39 - Point mark type  [1, 2, 3, 4]
40 - Crosshair enable/disable  [0, 1]
41 - Rubber band line enable/disable  [0, 1]
42 - Parallel-2 distance setting        ********NEW*********

60 - Tick mark segments  [0<=x<=10e6]
61 - Tick mark segment division  [0<=x<=10e6]
62 - Text horizontal scale  [0<=x<=10e6]

80 - Number of selected entities -- Not affected by Getattr or Putattr

Functions 90-99 are values for an entity just selected with the Entity
statement. They are all read_only values.

90 - Entity type
91 - Entity line type
92 - Entity color ** OBSOLETE**  Use SYS$(92) instead
93 - Entity layer
94 - Group Number (Solid number in DesignCAD 3-D)

96 - 128 or greater if entity is selected.�
97 - Line type scale.
98 - Line thickness
99 - Number of points

101 - Dimension type  [1, 2, 3, 4]

103 - Tolerance enable/disable  [0, 1]
104 - Arrowhead type  [1<=x<=12]

106 - Dimension precision  [-7<=x<=7]



120 - Minimum X value in the drawing.  [read_only]
121 - Minimum Y value in the drawing.  [read_only]
122 - Maximum X value in the drawing.  [read_only]�
123 - Maximum Y value in the drawing.  [read_only]

134 - Printer top margin
135 - Printer bottom margin
136 - Printer left margin
137 - Printer right margin

150 - Angle mode - 0=degrees, 1=grads, 2=radians,
      3=degrees-minuts-seconds, 4=bearings.
151 - Distance mode - 1=normal, 2=fractions, 3=feet-inches.
152 - Scale drawings on retrieval and copy option  1 = fixed;
     2 = changeable

181 - Number of available BasicCAD symbols.  [read_only]

190 - Handle 1 X value
191 - Handle 1 Y value
192 - Handle 2 X value
193 - Handle 2 Y value

300 - Current drawing color, Red   value.  [0-255]
301 - Current drawing color, Green value.  [0-255]
302 - Current drawing color, Blue  value.  [0-255]
303 - Hatch pattern color,   Red   value.  [0-255]
304 - Hatch pattern color,   Green value.  [0-255]
305 - Hatch pattern color,   Blue  value.  [0-255]
306 - Rubber band color,     Red   value.  [0-255]
307 - Rubber band color,     Green value.  [0-255]
308 - Rubber band color,     Blue  value.  [0-255]
309 - Grid color,            Red   value.  [0-255]
310 - Grid color,            Green value.  [0-255]
311 - Grid color,            Blue  value.  [0-255]
312 - Point color,           Red   value.  [0-255]
313 - Point color,           Green value.  [0-255]
314 - Point color,           Blue  value.  [0-255]
315 - Highlight color,       Red   value.  [0-255]
316 - Highlight color,       Green value.  [0-255]
317 - Highlight color,       Blue  value.  [0-255]
318 - Dimension color,       Red   value.  [0-255]
319 - Dimension color,       Green value.  [0-255]
320 - Dimension color,       Blue  value.  [0-255]
321 - Background color,      Red   value.  [0-255]
322 - Background color,      Green value.  [0-255]
323 - Background color,      Blue  value.  [0-255]
324 - Foreground color,      Red   value.  [0-255]
325 - Foreground color,      Green value.  [0-255]
326 - Foreground color,      Blue  value.  [0-255]
327 - Entity point color,    Red   value.  [0-255]
328 - Entity point color,    Green value.  [0-255]
329 - Entity point color,    Green value.  [0-255]

401 - Angular    dimension prefix  [0-5]



402 - Linear     dimension prefix  [0-5]
403 - Radius     dimension prefix  [0-5]
404 - Diameter   dimension prefix  [0-5]
405 - Chamfer    dimension prefix  [0-5]
406 - Coordinate dimension prefix  [0-5]
407 - Angular    dimension suffix  [0-5]
408 - Linear     dimension suffix  [0-5]
409 - Radius     dimension suffix  [0-5]
410 - Diameter   dimension suffix  [0-5]
411 - Chamfer    dimension suffix  [0-5]
412 - Coordinate dimension suffix  [0-5]
413 - Dimension layer  [0-255]

415 - Linear text location
416 - Linear text position
417 - Angular text position
418 - Linear text direction
419 - Angular text direction�

421 - Extended text type

424 - Linear text type
425 - Progressive text direction

428 - Angular dimension type

433 - Angular dimension precision

437 - Line connecting inward arrows
438 - Dimension text size
439 - Dimension text horizontal scale
440 - Dimension text slant
441 - Dimension tolerance text size
442 - Overshoot of Dimension extension lines
443 - Gap of Dimension extension lines
444 - Length of Dimension extension lines
445 - Arrow size
446 - Balloon size
447 - Dimension line offset for baseline dimension

450 - Dimension arc prefix
451 - Dimension arc suffix
452 - Radius dimension text position
453 - Text position
454 - Text position
455 - Text position
456 - Text direction
457 - Text direction
458 - Text direction
459 - Text direction
460 - Dimension arrowhead type

462 - Dimension arrowhead scale  [percentage of text size]

600 - Minimum X value of the current display screen        ********NEW*********
601 - Maximum X value of the current display screen       ********NEW*********



602 - Minimum Y value of the current display screen        ********NEW*********
603 - Maximim Y value of the current display screen        ********NEW*********

999 - Exit condition for last Input statement; 0 if <enter> or clicked <ok>
     1 if <esc> or clicked on <cancel>       ********NEW*********

The BasicCAD program ST.BSC included with these disks lets you explore the sys() functions at 
your leisure. SST.BSC lets you check out the sys$() functions. DEMO.BSC demonstrates many of
the newer changes to BasicCAD.

--------------------------------------------------------------------------------------------------------------------
--- Section 3 ---    Menu Customization
--------------------------------------------------------------------------------------------------------------------

You can customize your pulldown menu by creating a text file called DCMENU.INI in your 
DesignCAD directory according to the instructions below.

*****************  DCMENU.INI Description  *********************
This file allows you to modify your menu in DesignCAD 2D For Windows

All item counts start at 0; for example, the FILES menu is Menu 0. The first item is item 0, the 
second is item 1, etc.
******************************************************************

[DesignCAD 2-D]     *** This section MUST be at the beginning of the file
Version=7.0         *** All other sections optional; to disable a section without taking out the lines, 
just change the name in brackets (ex: change the section title below to [!Delete Menu Item]

[Delete Menu Item]  *** This section lets you delete an entire menu or individual items from a 
menu
MenuItem1=0,14      *** This line deletes the 15th item from the 1st menu (In this case, the Run 
command)
MenuItem2=7,4 5     *** Deletes 5th and 6th items from 8th menu
MenuItem3=7,4 5     *** Deletes 5th and 6th lines from WHAT IS LEFT of 8th menu after 
MenuItem 2 has been deleted

                   **** Format: MenuItemx=n1,n2,...(space)m(space)m+1...
                   **** MenuItemx is a string to describe the item to be deleted.  x should be unique.
                             (We recommend using consecutive numbers for x)

[Insert Sub Menu]   *** This section lets you add a pulldown menu
MenuItem1=&TestMenu,1  *** This line adds a new menu in the 2nd position titled TestMenu

[Insert Popup Menu] *** This sections allows you to add popup menus to existing pulldown 
menus

MenuItem1=&Run,0,14 *** Adds a popup menu titled "Run" to File menu at the 15th row.

[Insert Popup Sub Menu]  *** Adds popup menus inside popup menus
MenuItem1=&Custom,0,14,-1  *** Adds a popup menu "Custom" to Run popup in the File menu



[Insert Menu Item]   *** Adds actual commands to the menus
MenuItem1=&Run...,2350,0,14,0
MenuItem2=SEPARATOR,0,0,14,-1
MenuItem3=&Copy,11000,0,14,-1,e:\wdc\copy.bsc
MenuItem4=&Paste,11000,0,14,-1,e:\wdc\paste.bsc
MenuItem5=&About DesignCAD,2402,0,14,1,-1
MenuItem6=&Calculator,2409,0,14,1,-1
MenuItem7=SEPARATOR,0,0,14,1,-1
MenuItem8=&Paint,560,0,14,1,-1
MenuItem9=&About DesignCAD,2402,1,-1
MenuItem10=&Logic Symbols,12001

*********************  More comments  ***************************
    The & character tells the program to display the next character with an underline in the Menu; 
for example, in MenuItem1 of the section just above, the & in front of "Run..." means that the "R" 
will be the "hot key" to issue that command. It does not have to be in front of the first letter. For 
example, "E&xit" is legal. The word "Exit" will appear in the menu with "x" underlined

    The format of the [Insert Menu Item] section lines is:

MenuItemx=CommandName,Commandnumber,menu,line number[line number[line number][line 
number]...]

"x" in MenuItemx should be a unique string [numbers recommended]

CommandName is what name you want to appear in the menu for that command.

Commandnumber is situational; if you are using one of the commands listed in 
DCMACRO.SYS, then use the number for that command. If you are running a BasicCad 
program, use 11000. (Note that not all of the commands in DCMACRO.SYS can be run in this 
fashion; Textblock is one example.)

menu is the number STARTING AT 0, not 1, of the pulldown menu you are modifying. 0 would 
represent the File menu normally (unless you have disabled it or replaced it above)

line number is the number of the line at which the item is to be inserted into the menu. A -1 will 
always place your MenuItem at the end of the menu. If line number n represents a popup menu, 
then it must be followed by another line number for THAT menu, etc.

SEPARATOR adds a separator line into the menu. It has no commandnumber, so we place a 0 in
that field. When calculating which line is to be modified, you must count the separator lines along 
with actual commands and popup titles.

--------------------------------------------------------------------------------------------------------------------
--- Section 4 ---    ToolBox Customization
--------------------------------------------------------------------------------------------------------------------
The file DCTOOL.INI lets you customize the tools available in the main toolbox.

**************** DCTOOL.INI Description *********************

[DesignCAD 2-D]   *** This section MUST be in the file
Version=7.0

[Toolbox Command]    *** This section remaps your MAIN toolbox; to disable it, put a             
        semicolon or asterisk in front of "Toolbox", like so:



                                           [;Toolbox Command]

Command1=14,2379 2349 2380 1542 1537 1538 1541
Command2=15,554 555 556 1546 
Command3=16,12001 12002 12003

******************************************************************
                         *** Format of Command lines ***

Commandx=BoxNumber,CommandNumber CommandNumber CommandNumber ...

x is a unique identifier for that particular line; recommend using numbers.

BoxNumber is the number, starting at 0, of the command box you are modifying. Counting is left 
to right, starting at the top, and working down the toolbox. If your toolbox is set up for 2 columns, 
then the first box on the top row is 0, the second is 1. The first box on the next row is 2, the 
second is 3, etc. BoxNumber can only range from 0 to 19, for a total of 20 toolbox "drawers". 
(**Note -- former limit was 18. Changed 08-03-94.)

CommandNumber is the number in DCMACRO.SYS across from the name of the command you 
want in that position. Consecutive CommandNumbers are separated by spaces, not commas. 
Note that not all commands in DCMACRO.SYS will be useable in the toolbox, and of the ones 
that are, not all have graphical icons. Some CommandNumber values will give you empty gray 
space in your toolbox, but if the command is legitemate, clicking on that space will run the 
command. Usually you will also see a prompt in the status bar when you click on valid 
commands.

You are limited to no more than 20 (** formerly 18) tools, or CommandNumbers, per line. 

--------------------------------------------------------------------------------------------------------------------
--- Section 5 ---    Symbol ToolBox Customization
--------------------------------------------------------------------------------------------------------------------

*********** DCSYMBOL.INI and DCHOTOOL.INI Description ******************

Improved Symbol Capabilities For DCW

Now you can add more than one symbol toolbox to DesignCAD for Windows.
You need to create a file called DCSYMBOL.INI. The file is divided into
up to 40 sections (you can have up to 40 "pages" of up to 40 symbols
each).

Each section header is as follows, and NN is replaced by a number from 1
to 40:

[Symbol Group NN]

After the heading, list all of the symbols for that "page" of the symbol
toolbox, as follows:

SymbolTool1=d:\dir\subdir\symbol1.dw2
SymbolTool2=d:\dir\subdir\symbol2.dw2



.

.

.
SymbolTool40=d:\dir\subdir\symbol40.dw2

Note that the symbol group listings should be in numerical order, with
no skipping of numbers.

You can also include labels for each symbol which will appear on the
status bar below as you move the cursor over each symbol:

SymbolLabel1=Any descriptive text you want --and DON'T use quotes
SymbolLabel2=Some text about Symbol 2

Note that the number X in SymbolLabelX directly corresponds to the
number X in SymbolToolX. The ORDER is not important for the labels; only
the numbers in the descriptors. To avoid confusion, we recommend that
you match the order. If you omit a label for one of the symbols, the
path and filename will be displayed when you move the cursor over that
symbol in the symbol toolbox.

The sample file below illustrates these principles (either format is
acceptable):

------ DCSYMBOL.INI  (This line is NOT part of the file)------------------

[Symbol Group 1]
SymbolTool1=c:\dcad\symbol\electron\nand.dw2
SymbolTool2=c:\dcad\symbol\electron\nor.dw2
SymbolTool3=c:\dcad\symbol\electron\not.dw2
SymbolTool4=c:\dcad\symbol\electron\and.dw2
SymbolTool5=c:\dcad\symbol\electron\or.dw2
SymbolTool6=c:\dcad\symbol\electron\xor.dw2
SymbolLabel1=NAND Gate
SymbolLabel2=NOR Gate
SymbolLabel3=NOT Gate
SymbolLabel4=AND Gate
SymbolLabel5=OR Gate
SymbolLabel6=XOR Gate

[Symbol Group 2]
SymbolTool1=c:\dcad\symbol\arch\firepl1.dw2
SymbolLabel1=Fireplace 1
SymbolTool2=c:\dcad\symbol\arch\firepl2.dw2
SymbolLabel2=Fireplace 2
SymbolTool3=c:\dcad\symbol\arch\firepl3.dw2
SymbolLabel3=Fireplace 3
SymbolTool4=c:\dcad\symbol\arch\firepl4.dw2
SymbolLabel4=Fireplace 4
SymbolTool5=c:\dcad\symbol\arch\firepl5.dw2
SymbolLabel5=Fireplace 5
SymbolTool6=c:\dcad\symbol\arch\firepl6.dw2
SymbolLabel6=Fireplace 6



-----End of DCSYMBOL.INI  (this line not part of the file) --------------------

Once you have a DCSYMBOL.INI file, you need to tell DesignCAD that it is
there. You can access these symbol menus from the pulldown menu, or from
the hot toolbox, or from the main toolbox. The easiest way to get access
to it is from the hot toolbox. You must create DCHOTOOL.INI:

----------- DCHOTOOL.INI (this line not part of file) --------------------

[HotToolCmd]
Show=1      ; 1 is visible -- 0 is not visible
Command1=12001
Command2=12002
Command3=12003
Command4=12004
Command5=12005
.
.
.
CommandNN=120NN

---------------End of DCHOTOOL.INI (not part of the file) ----------------

The choices in DCHOTOOL.INI will replace all items occupying the same 
relative positions in an existing hot toolbox. The total number of tools and
symbol groups should not exceed 40. You can also use numbers for other 
DesignCAD drawing commands; this .INI file is not necessarily meant just 
for symbol groups. You can combine symbol groups and hot tools in the 
same toolbox. If you had a hot toolbox previously, just add the command 
numbers to this file that appear in DCW.INI as:

HotToolCmdn=512

becomes:

Commandn=512

Order is not important. You can mix drawing commands with symbol groups
in any order you please.

To add symbol groups to the pulldown menu, see Section 3 of this file, and
use a number in the range 12001 - 12040 for the command number.

To add symbol groups to the main toolbox, see Section 4 of this file, and
use a command number in the range 12001-12040

If symbol groups are added to either the Hot Toolbox or the Main Toolbox, an 
icon will appear in that toolbox as "Group N", where N is the group number. 
There are icons for groups 1 through 40.

"How do I know six weeks from now what Group 27 represents unless I click on
it?" you are probably wondering. Well, there is YET ANOTHER  .ini file (YAIF) 
that you can create to give you prompts on the status line as you wave your 
cursor over the group icon or the appropriate spot in the pulldown menu. See 
Section 6 of this file for more information.



--------------------------------------------------------------------------------------------------------------------
--- Section 6 ---    Command Prompt Customization
--------------------------------------------------------------------------------------------------------------------

***********************  DCPMT.INI Description ************************

The DCPMT.INI file allows you to modify the command descriptions and prompts in
DesignCAD for Windows.

***********************************************************************

[Application Menu Title]

;this section applies only when no document is open for editing. For most purposes you 
can ;leave it empty
;PmtIDnX=Prompt string for the menu title
;n is the number of the menu title, starting with 1 at the left.
; -- NOTE: this is different from DCMENU.INI and DCTOOL.INI, which both
;    start the count at 0. Don't get them confused, please.

PmtID1X=No Drawing Open

;1 is the first (and only) menu: Files
;When you click on the Files menu title with no drawing screen open for
;editing, this prompt tells you that no drawing is currently open.

[Application Menu Item]

;this section also applies only when no document is open for editing.

PmtID2304X=Start a fresh drawing completely from scratch

;2304 is the number of the NEW command (see dcmacro.sys for numbers of
;commands)

[Document Menu Title]

; This and subsequent sections apply whenever a document is open for
; editing. This section lets you modify the description of each menu
; heading, shown in the status bar when you click the mouse over that heading.
;
;PmtIDnX=Some string NOT enclosed in quotes
;
;n is the number of the menu heading (starting from 1, as above. Again,
;this is different that the scheme in DCMENU.INI and DCTOOL.INI.
;1, for example, is for FILES, 2 for EDIT, etc.

PmtID4X=Drawing Commands
PmtID5X=Text and Dimension Commands
PmtID6X=Hatch Pattern Commands
PmtID7X=Special Commands
PmtID8X=Windows Commands
PmtID9X=Help



[Document Submenu Title]

; This section modifies the descriptions for a popup submenu under the
; main menu heading. Each popup menu is identified by the command number
; the first command in the popup menu.

;PmtIDnX=Prompt for submenu item; n is the command number for the first command in 
the ;popup menu

PmtID2332x=Import or export a DesignCAD drawing

;2332 is the command number for ImportDXF. Since it is the first command
;in the Import/Export popup menu, it serves as the identifier for that
;submenu

[Document Menu Item]

; This section modifies the description for the individual commands in
; the pulldown menus or in the toolboxes. Symbol groups will be
; identified by an ID of 12001-12040. Drawing command numbers can be 
; obtained from the file DCMACRO.SYS. These prompts will activate as 
; you move the highlight bar over the menu item in question 

PmtID12001X=Symbols - Misc. Drawings 1
;Symbol Group 1
PmtID12002X=Symbols - Misc. Drawings 2
PmtID12003X=Symbols - Logic Gates
PmtID12004x=Symbols - Fireplaces
PmtID12005x=Symbols - Transistors
PmtID556X=Fill Area
;Hatch fill command
PmtID2332x=Are you SURE you want to import a DXF file?
;Import DXF file
PmtID2333X=Are you SURE you want to import an IGES file?
;Import DXF file

[Command Execution Prompt]

; This section modifies the prompts shown while a command is executing.
; This only applies for commands that depend on the user to set points
; manually. Commands which bring up a dialog box will generally use the
; prompt given in the [Document Menu Item] section above.

PmtID556X=Click inside a closed area to fill with selected pattern.
; the above prompt shows while Hatchfill is waiting for you to set a
; point.

PmtID2332X=Well, if you're SURE... Go ahead.
; the above prompt never appears, because Import DXF brings up a text
; dialog box. While it waits for your actions, the [Document Menu Item]
; prompt appears in the status bar.

;below is an uncommented sample DCPMT.INI file:



*********(This line is NOT part of the file)**************

[Application Menu Title]
PmtID1X=No Drawing Is Currently Open

[Application Menu Item]
PmtID2304X=Start work on a new drawing.
PmtID2305X=Open an existing drawing.

[Document Menu Title]
PmtID4X=Drawing Commands
PmtID5X=Text and Dimension Commands
PmtID6X=Hatch Pattern Commands
PmtID7X=Special Commands
PmtID8X=Windows Commands
PmtID9X=Help

[Document Submenu Title]
PmtID2332x=Import or export a DesignCAD drawing

[Document Menu Item]
PmtID12001X=Symbols - Misc. Drawings 1
PmtID12002X=Symbols - Misc. Drawings 2
PmtID12003X=Symbols - Logic Gates
PmtID12004x=Symbols - Fireplaces
PmtID12005x=Symbols - Transistors
PmtID556X=Fill Enclosed Area With Pattern
PmtID2332x=Are you SURE you want to import a DXF file?

[Command Execution Prompt]
PmtID556X=Click inside a closed area to fill with selected pattern.


